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Experiment HM-8: The Electrogastrogram (EGG) and the Growling Stomach

Background

Do you ever wonder why your stomach “growls,” that funny sound it makes when you are really 

hungry? Stomach growling is the result of the process of peristalsis, the moving of the solid and liquid 

stomach contents along with gasses and air. As these ingredients get pushed around and broken down, 

the pockets of air and gas also get squeezed and create the noises we associate with the “growling” 

sound. Stomach growling can happen at any time, not just when you're hungry. However, if there is 

food already in your stomach or small intestine, the growling becomes quieter. It's like putting a 

baseball in the dryer by itself compared with a load of towels; the towels muffle the noise of the ball as 

it bangs around.

If your stomach is empty, why are the muscle contractions happening at all? The main reason is hunger.

Approximately two hours after your stomach empties itself, it begins to produce hormones that send a 

message to your brain, the brain replies by signaling for the digestive muscles to restart the process of 

peristalsis. Two things happen: the contractions grab any remaining food that was missed the first time 

around, and the vibrations of an empty stomach make you hungry. These muscle contractions will come

and go about every hour, lasting about 10 to 20 minutes, until you eat again (Figure HM-8-B1).

Figure HM-8-B1: Stomach diagram

The Electrogastrogram (EGG) records the electrical signals that travel through the muscles of the 

stomach controlling these contractions. An EGG can also measure stomach wall nerve activity before 

and after food ingestion. Gastric muscle activity is mainly composed of two complementary rhythms: 

slow wave activity, responsible for muscle contraction timing which occurs at approximately 3 cycles 

per minute (0.05 Hz); and the electrical response activity which is responsible for triggering peristaltic 

contractions. The EGG can be used to measure too much activity, tachygastria, too little activity, 

bradygastria, or a mixed dysfunction of both too much and too little activity. 
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To record an EGG, electrodes are placed on the skin of the abdomen just below the stomach on the left 

side of the body. While the subject is lying down and relaxing, a recording is done of the electrical 

activity of the stomach and/or intestines. The gastric electrical activity is recorded after fasting for 

approximately 15-20 minutes, then again after a small meal is eaten for the same length of time. It is 

important that the stomach be empty prior to the start of the test. Utilizing the LabScribe software, the 

frequency of the waves and the power of the stomach muscle electrical activity is measured. In normal 

stomach muscle response, the regular electrical rhythm generates an increased current and slower 

rhythm after a meal. 

Experiment HM-8: The Electrogastrogram (EGG) and the Growling Stomach

Equipment Required

PC or Mac Computer

IXTA data acquisition unit

USB cable

IXTA power supply

iWire-B3G EGG cable and electrode lead wires

Disposable electrodes

Alcohol swabs

Electronic Stethoscope - optional

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power 

socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the labeled socket on the rear of the IXTA. Turn the power switch on. 

Confirm that the power light is lit.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.
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3. Locate the folder that contains the settings group, IPLMv6Complete.iwxgrp. Select this group 

and click Open.

4. Pull down the Settings menu again. Select the EGG-GrowlingStomach settings file from 

Human Muscle.

5. After a short time, LabScribe will appear on the computer screen as configured by the EGG-

GrowlingStomach settings.

6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are programmed on the Preferences Dialog window which can be viewed by

selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

EGG Cable Setup

1. Locate the iWire-B3G EGG cable and electrode lead wires (Figure HM-8-S1) in the iWorx kit.

Figure HM-8-S1: The iWire-B3G EGG cable with three lead wires attached.
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Figure HM-8-S2: The iWire-B3G EGG cable and leads connected to an IXTA.

Figure HM-8-S3: Placement of EGG electrodes on the abdomen.

2. Insert the onnector on the end of the iWire-B3G EGG cable into the iWire 1 input on the front 

of the IXTA (Figure HM-8-S2). 

Note - Make sure to connecct the iWire-B3G to the IXTA prior to turning it on.

3. Insert the connectors on the red, black, and green electrode lead wires into the matching sockets

on the iWire-B3G.

4. The subject should remove all jewelry. 

5. Use an alcohol swab to clean and scrub three regions on the left side of the subject’s abdomen 

where the electrodes will be placed (Figure HM-8-S3). One area is approximately 3 cm to the 

left of the umbilicus (belly button), the second is above the first, and the third is just below and 
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about 1 cm more to the lateral edge of the abdomen (left).

6. Let the areas dry before attaching the electrodes.

7. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas. 

Repeat for the other two areas. 

8. Snap the lead wires onto the electrodes, so that:

• the green “C” lead (the ground) is attached to the electrode adjacent to the belly button.

• the red “+1” lead is attached to the electrode above the green lead.

• the black “-1” lead is attached to the electrode below and to the left of the green lead.

Experiment HM-8: The Electrogastrogram (EGG) and the Growling Stomach

Exercise 1: EGG on an Empty Stomach

Aim: To determine the relationship between the frequency and power of EGG activity on an empty 

stomach.

Procedure

Note: The subject must have an empty stomach.  The subject should not have ingested any food for at 

least 3 hours prior to this experiment.

1. The subject should get into a supine position, with eyes closed. It is important that the subject is

lying completely still during the recording. 

2. Click the Record button to begin recording.  

3. Record for a minimum of 15 minutes while the subject is lying prone with an empty stomach. 

Clinical EGG recordings are approximately 2 hours in length; however, a general understanding

of the muscle activity can be seen in less time.  The longer the recording, the more accurate the 

data.  Do not record for longer than 30 minutes.

4. Click the Stop button after the desired length of recording.  The recording should be similar to 

Figure HM-8-L1.

5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click 

on the Save button to save the data file. 
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Figure HM-8-L1: The EGG recording in the Main window of a supine subject with an empty stomach.  

Note the fluctuations in muscle activity over the course of the recording. 

Exercise 2: EGG on a Full Stomach

Aim: To determine the relationship between the frequency and power of EGG activity on a full 

stomach.

Procedure

Note: The subject will eat a small meal.  Have some food ready for the subject to eat.  This can include 

a sandwich, fruit, desert and a small non-carbonated drink.  

1. The subject should sit up and eat a small meal within 15 minutes.

2. Have the subject then get back into a supine position, with eyes closed. It is important that the 

subject is lying completely still during the recording. 

3. Follow the same directions as in Exercise 1, recording EGG activity for the same length of time.

4. Click the Stop button after the desired length of recording.  

5. Click on the Save button to save the data file. 

Data Analysis for both Exercise 1 and Exercise 2

This lab uses the Fast Fourier Transform analysis routine in LabScribe.  The FFT function allows the 

user to look at both the frequency and the power output of a section of data recorded over time.  

The way the FFT works is relatively straightforward. It takes a chunk of time called a frame, a certain 

number of samples of data, and considers that chunk to be a single period of a repeating waveform. The

reason that this works is that most EGG activity are "locally stationary,” meaning that over any period 
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of time, the muscle contractions look like a regularly repeating function. 

The stomach muscles contract at regular intervals, giving a repeating rhythmic electrical signal that is 

recorded by the electrodes placed on the abdomen. In a subject at rest with an empty stomach, the 

rhythm of the contraction is approximately three cycles per minute or about 0.05 Hz. The power and 

frequency of the signal will change after the subject eats a small meal.  

1. Use the Display Time icons to adjust the Display Time of the Main window to show the 

complete set of EGG muscle contractions for an Empty Stomach on the Main window. The data

can also be selected by:

• Placing the cursors on either side the 15 minutes (or so) of data; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 

segment with the four contractions to the width of the Main window.

2. Click on the FFT window icon in the toolbar (Figure HM-8-L2) or select FFT from the 

Windows menu to transfer the data displayed in the Main window to the FFT window (Figure 

HM-8-L4).

Figure HM-8-L2: The LabScribe toolbar.

4. Look at the new FFT window that opens.  In the top section of the window is a direct copy of 

the raw data from the main window.

• Click and move the two vertical cursors so they are at either end of the data shown.

• A histogram will be shown in the lower window as the cursors are moved into the 

correct position.

5. On the lower window:

• Choose 0.01 Hz from the Freq. Resolution drop down menu to the right of the FFT 

Toolbar (Figure HM-8-L3).

• Click AutoScale to expand the histogram as shown in Figure HM-8-L4.

Figure HM-8-L3: The FFT Toolbar.
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• Click and move the two vertical cursors so that they are placed in the correct positions 

zooming in on the “interesting” section of data at the beginning of the FFT window. 

• Click the “Zoom Between Cursors” (“+”) button located between the Half and Double 

Display time buttons.  This will expand the section of data showing the frequency and 

power of the EGG muscle contractions while the stomach is empty.

6. Move the left hand cursor to the first, largest peak.  Look at the data for Freq1 and Power1 for 

the frequency of the stomach contractions and the strength, or power, of those contractions 

(Figure HM-8-L4).

7. The functions in the Power Spectrum of the Electrogastrogram pull-down menu of the FFT 

window can also be used to enter the names and values of Freq1 and Power1 to the Journal. To 

use these functions:

• Place the left hand cursor at the location noted above.  It does not matter where the right 

hand cursor is located.

• Transfer the name of the mathematical function used to determine the Freq1 and Power1

to the Journal using the Add Title to Journal function in the pull-down menu.

• Transfer the values for the frequency and power to the Journal using the Add All Data to 

Journal function in the pull-down menu.

• The graph can also be copied using the pull-down menu.

7. Record the values for the Frequency and Power on an Empty Stomach in the Journal using the 

one of the techniques described above and on Table HM-8-L1. 

8. Select Save from the File menu.
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Figure HM-8-L4: The frequency and power of the EGG shown in the FFT window. The left hand 

cursor is placed on the peak of the highest wave in the histogram.  The frequency and power are shown

in the upper left of the graph.

9. Repeat Steps 1 through 8 for the data in Exercise 2 when the subject has a full stomach.

10. Select Save from the File menu.

Questions

1. Was there a change in the frequency and power of the EGG waves before and after eating?

2. What is the physiologic relationship between frequency and power of the EGG contractions, 

whether before or after ingesting food?

3. Why is there a change in the frequency of the contractions after eating?

4. Why is there a change in the power of contractions after eating?

5. What are the physiologic causes for any changes seen in the subject's EGG after eating?
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Table HM-8-L1:The Effect of Food on EGG Activity in a Supine Subject.

FFT Analysis of Electrogastrogram (EGG) Activity

Supine Subject
Frequency of EGG waves 

(Hz)
Power 

Before Eating

After Eating

Optional Exercise: 

Plug the ES-300 Electronic Stethoscope into the iWorx data recorder to listen to the growling sounds of

the digestive system while recording on both an empty and full stomach.
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